
   1  

 

1  

 

 
 

Quick Start Guide for Testing 

The Quick Start Guide for Testing helps you to have a quick understanding of IPG system, and evaluate the 

basic function such as calling, monitoring and configuring the 2-Wire IP Network System 

 

1. Testing system layout 
 

Simulated Apartment 

 

With this minimal 2-Wire IP Network system, some major functions and operations as below could be tested: 

1. Guard Station calling and monitoring. 

2. Common Door station calling 

3. Intercom between Monitor and Guard Station, surveillance from Monitor to Door stations. 

4. Configure and diagnosis the system via DX_Builder 

 
2. System Consists 

This Evaluate Kit includes: 

     5 Ports LAN Switcher *1 

     Cat5 Cable *4 

     DPM-D246-IP *1 

     DPA-D2-IPG  *2 

While you still need prepare below items: 

 DPC-D218ID-S *2 

 Indoor Monitor*2 

 PC6A*3 

 2-Wire Cables 

Note: 

The Building door station could be replaced any pushbutton door station such as DPC-D221 and DPC-D268 series, while DPC-

D218ID-S with numeric dialing and Namellist function. But you can still sign an empty call button for Guard Station, see 

Appendix 2. 

DPC-D218ID-S must upgrade to firmware version V000205 before test, see Appendix 1. 

Monitors could be wire as IN-OUT without DBC4A, and not need to upgrade 
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3. Wiring diagram 
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4. Test without configuration. 

DPA-D2-IPG and DPM-D246-IP with built-in configuration allow users built the system without any  

complicated settings. 
 

 

Basic settings: 
 

Common Door Station 

Only DMR8S can work as CDS, and it must be upgraded to firmware version V000205, see appendix.1 
 

DPA-D2-IPG  

IP_Node_ID configure by the DIP switches, set as the diagram, 63 and 01 
 

Building Door Station 

If using DPC-D218ID-S as BDS, it must be upgraded to version V000205, while using pushbutton (DPC-D221 and 

DPC-D268 series), is not required to do so. Door station’s device id shall set to 00. 

DBC4A 

Video match set to ON as the last distributor. 
 

Monitor 

Monitors are work in apartment, set the address from 01 to 02. 
 
 
 
 
 
 

Note: 

After upgrade procedure as appendix.1, keep all DPC-D218ID-S as the default settings. 

When pushbutton door station work as Building’s door station, it is not able to call Guard Station without configure. 

Enable auto calling or set the doorplate mode might disable the function for calling to Guard Station 

Building  Door station 

 

 

 

 

Upgraded 

 

 

 

 

 

 

 

 

 

 

Common  door station 
 

 

 

Upgraded 
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Call from Door Station to Guard Station 

Enter 201000 + # to call. 

 

 

5. Function test without configuration 

Any below calling/surveillance function could be tested on the system you just set. 
 

IM_ADD = 01 IM_ADD = 02 

 
 
 

 

 
 
 

 

201 
 

 
 
 

 
 
 

Note: If using pushbutton door station is not able to 

call Guard Station unless configure via DX_Builder 
 

  
 
 
 

 

Calling or surveillance from DPM-D246-IP by input codes as above 
 
 

1. Touch the “Input Mode” icon. 2. Enter call codes as above 3. Touch icon on the panel 

  

 

Call from Building Door Station to Monitor 

Enter 01 or 02 + # to call. 

Call from Building Door Station to Monitor 

Enter 002001 or 002002 + # to call. 

Surveillance from Guard Station to Door Station 

Enter 002001 or 063001 touch “Surveillance” 

icon to check. 

Surveillance from Monitor to Door Station 

Select “DS1” or “DS4” in the monitoring list to 

check (this function isn't fully implemented). 

1 2 3 

4 2 3 

5 2 3 

 

2 3 5 1 4 5 

5 1 4 2 3 4 

Call from Guard Station to Monitor 

Enter 002001 or 002002 and touch 

“Phone” icon to call. 

Call from Monitor to Guard Station 

Select the “Call Guard Unit” in the 

intercom function to call. 
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6. State check and Data diagnostic 

 
Indicators of DPA-D2-IPG  

Indicators on the DPA-D2-IPG  have a simple and clear meaning for IPG’s state 
 

State LED Power In-Use Net Video 

OFF Outage Idle Off Line VD_Idle 

ON Powered Talking On Line Server 

Fast Flashing Device Error Out-Call Caller - VD C&S 

Normal Flashing Kernel Booting In-Call Callee - Video Client 

Short irregular Flashing App Booting Call Busy -  

Long Irregular Flashing FW Update - -  

 

Buttons of DPA-D2-IPG  

To have a quick state check via button, just press once on the buttons, and below information you can check: 
 

Press Button Check Call DT-CHK IP-CHK 

Once TIP/RING Enforce Call DT device check Network check 

 

TIP/Ring 

This is a locate function working cooperatively with PC software DX-Builder. 

By pressing CHECK button, the DPA-D2-IPG will send a signal to DX-Builder to indicate which the DPA-D2-

IPG  is and show all the information about it. Also from the DX-Builder, installer can ring a DPA-D2-IPG  to 

check where it is, the DPA-D2-IPG  will response by indicator flashing. 

Enforce Call 

By press the CALL button, the DPA-D2-IPG will force to launch a call from door station (default DS_ID=00) to 

the Guard Station (default IP_NODE_ID=201). Because all the involved devices are with default 

configurations, this function mostly is used to check connection of system during project installation. 

Online check for 2-Wire system device 

DPA-D2-IPG  will check online with door stations (DS_ID=00, DS_ID=01) and monitors (IM_ADD=00, 

IM_ADD=01) which connected in this system automatically after pressing the DT-CHK button. The 4 LEDs 

on DPA-D2-IPG  are corresponding to the 4 checked devices. The LED will light on for 3 seconds if the device 

is online, otherwise it is offline. 

Online check for IP network devices 

DPA-D2-IPG  will check online with IP network devices with IP_NODE_ID=1, 2, 201& 202 which connected 

in this system automatically after pressing the IP-CHK button. The 4 LEDs on DPA-D2-IPG  are corresponding 

to the 4 checked devices. The LED will light on for 3 seconds if the device is online, otherwise it is offline. 
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LAN Network inspection 

On the first time to go into the Debug Mode the system will 

show basic information on the screen about the IPG which the 

DPC-D218ID-S connected with. 

 
First: IP_Node + IP_address + State of DPA-D2-IPG  connected with. 

Second: Hardware version + Firmware version of DPA-D2-IPG . 

Input call codes in Debug Mode 

To avoid the erroneous “Doorplate mode” or “Namelist” settings on DPC-D218ID-S in 2-Wire IP Network, 

debug calling will leave all those settings behind and use a fixed input format: 

0 + [IP_Node_ID 3 digits] + [Device_Address 4digits] 
 

To call out debug calling, long press and hold key “0”, until the screen display as below, then you could enter 

the calling codes: 

 

Example inputs: 

 
 

Common Door Station Call Monitor 
 

Enter: +00010001 + # 
 

Common Door Station Call Guard Station 
 

Enter: +02010001 + # 
 

Common Door Station Call Doro Station* 
 

Enter: +00320001 + # 
 

*Only audio intercom, only available in debug calling mode. 
 

If calling under “Debug Mode” (#9008), on the top of the screen will show the communication data, this 

data helps you diagnose. 
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7. Advance configure via DX_Builder 

 
PC LAN Network Settings 

The DPA-D2-IPG  and DPM-D246-IP’s default IP address is 192.168.243.XXX. The PC will need to be set in 

the same subnet in order to connect to the DPA-D2-IPG s and DPM-D246-IPs 

a) Open Control Panel 

- Windows XP® (Classic View) -> Network Connections -> Double click Local Area Connection to open 

Connection Status window. 

- Windows 7/8/10® (Category View) -> Network and Internet -> View network status and tasks -> Click 

Local Area Connection to open the Local Area Connection Status window. 

b) Click the Properties button to open Local Area Connection Properties window. 

c) Scroll down and left click Internet Protocol (TCP/IP) then click Properties button to open Internet 

Protocol Properties window. 

d) Select the  ○*  Use the following IP address radio button. Type in the IP address 192.168.243.233 (the 

last number can be any valid host address except 0~232 and change the subnet mask to 255.255.255.0. 

Click [OK]. 

e) Click [OK] in Connection Properties window to accept these changes. 
 

Connections 
 

PC connects on the same LAN Switcher, 

and set the IP address settings as above 

Here using IP address: 192.168.243.235 

And DPA-D2-IPG  by DIP switches with 63 

and 01 will automatically fit to IP 

address: 192.168.243.1 and 

192.168.243.63. 

DPM-D246-IP keep as default will be: 

192.168.243.201 

 

Simulated Apartment 

 

Opening DX_Builder 

1) Connect all DPA-D2-IPG s and DPM-D246-IP as above diagram and programing PC to the same network 

2) Decompression the “DX_Builder.rar” 

3) Open folder “DX_Builder” -> open folder “bin” -> double click on “DX_Bulider.exe” 
 

Opening project file 

Opening a configured project file “TestDemo-EvalTest.pf” which is customized for the test system, and test 

it. Below steps helps you to download this project files to IP devices and test. 

1. Click “File” -> “Open” to open the project 
 

Building Door station 
IM01 

Common door station  

192.168.243.201 PC with Dx_Builder 

192.168.243.63 
192.168.243.235 

 
 

IM02 

 
192.168.243.1 
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2. With the window popped up, select “TestDemo-EvalTest.pf” file and click “Open” 

Online checking and Download 
 

1. Once the project file be loaded and the screen will show as below, first scan all IP devices to check 

those devices online or not. 

1) Click to select main title. 

2) Click on the “Setting Window”. 

3) Click to select all IP devices 

4) Click to scan all selected IP devices, check if those devices online or not 
 

2. All selected devices will be scanned, “√Online” if device is connected. 
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Click 

Click 

to select all IP devices need to configured 

to start download configure files to selected IP devices 

 
 

Configurations download for IP Devices 

To activate configuration for DPA-D2-IPG and DPM-D246-IP, you need to download all configured files to those 
devices. 

1. Prepare for the download procedure 

1) Click to select main title. 

2) Click on the “Setting window” 

3) Click to get ready the download procedure 
 

2. With the window popped up after step1, please do a 

1) 

2) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
3. All progress bars go to 100% the download procedure is finish. 
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DS_ID = 00 

INPUT = 01 

NAME = Gate 

IP_NODE_ID  = 11 

INPUT_Prefix = 1 

IP_NODE_ID = 63 IP_NODE_ID = 201 
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8.  Function test with configuration 

Any following calling/surveillance function could be tested on the system you just set 
 

IM_ADD = 01 

INPUT = 101 

NAME  = 01Alexander 

 

IM_ADD = 02 

INPUT = 102 

NAME  = 02Graham 

 

 
 

 

 
 

INPUT = 01 

 

INPUT_Prefix=99 
 

INPUT = 0 

NAME  Guard Station 

NAME=  Main Entrance 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 
 

By Device Address, this kind of calling is just a backup option, most of time after configure via DX_Builder, calling by 

input is recommended. 

Call from Building Door Station to Monitor 

By Input: Enter 101 or 102 + # to call. 

By Namelist: Touch “Bell” icon and select 

name to call 

By Device Address: Enter 001001 or 001002 

+ # to call 

 

Surveillance from Monitor to Door Station 

Select “DS1” or “DS4” in the monitoring list to check. 

4 2 3 

1 4 5 

Surveillance from Guard Station to Door Station 

By Input: 

Enter 133 or 001001 then touch "surveillance" icon to check Gate 

Enter 9901 or 063001then touch on "surveillance" icon to check Main Entrance 

By List: 

Select “Gate” or “Main Entrance” to monitoring 

2 3 4 

 

1 2 3 

5 2 3 

Call from Guard Station to Monitor 

By Input: Enter 1101 or 1102 + # to call. 

By Namelist: In the “Intercom” select name 

to call 

By Device Address: Enter 001001 or 001002 

+ # to call 

Call from Door Station to Guard Station 

By Input: Enter 0 + # to call. 

By Namelist: In the “Intercom” select 

name to call 

By Device Address: Enter 201000+ # to call 

Call from Common Door Station to Monitor 

By Input: Enter 1101 or 1102 + # to call. 

By Namelist: Touch “Bell” icon and select 

name to call 

By Device Address: Enter 001001 or 001002 

+ # to call 

5 1 4 

2 3 5 

Call from Monitor to Guard Station 

Select the “Call Guard Unit” in the 

intercom function to call. 
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Appendix1: Firmware Update for DPC-D218ID-S 

If your Evaluate Kit containing a SD card, and which you could use directly for the firmware update. If not, 

you need to prepare a SD card. (Best with storage no more than 8Gbits), and do as follow steps: 

1. Copy the firmware file “DPC-D218ID-S.bin” to the root directory of SD card 
 

2. Enter # + 8014 + admin code (6666666 by default) when DPC-D218ID-S is standby, the screen will 

shows as below: 

 

3. Enter key “1” to get firmware update ready, then click in the SD card: 

4. After firmware updated, initialize the DPC-D218ID-S is a must, enter # + 8013 + 85548008 in the 

standby mode, and input YYYY/MM/DD for the initialize date. ex. 20170429. 
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Appendix2: Difference when using DPC-D250 as building door station 

 
Using DPC-D250/S4 as Building door station 

Without configure via DX-Builder before testing, DPC-D250/DPC-D221/DMR11S as building door station 

won’t able to call Guard Station 

While with configuration, the same file "TestDemo-EvalTest.pf" downloaded, DPC-D250 / DPC-
D221/DMR11S to call Guard station as below 

 
 
 

 

 

 
 
 
 
 
 

Using DT601/602 as Building door station, set the address IM_ADD = 16, 00(32) 

In this case for calling pushbutton all be use for monitors, is not able to call Guard Station 
 

 

1 5 

Call from Door Station to Guard Station 

Push the 4th pushbutton to call guard station 


